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The Das Universal Bootloader (U-Boot) isa
firmware/bootloader for hardware platforms. The U-Boot is
widely used in embedded designs. The U-Boot supports
common processor architectures such as ARM®, Power
Architecture®, M icroprocessor without Interlocked Pipeline
Stages (MIPS), and x86%. In addition to the bootstrapping
functionality, the U-Boot al so supportsother featuresthat are
part of the open source project, which is available under
Genera Purpose Line (GPL). For example: device drivers,
networking and file systems support, utilities to assist board
bring up, testing, and so on.

The U-Boot firmware is ported to operate on severa i.MX
application processors and devel opment boards. However,
customers are often required to adapt to some key areas of
the source code to make the source code operate on a new
hardware platform based on the i.M X processor.

This application note deals with the i.MX25 3-stack U-Boot
source code where adaptation is required. Also, this
application note define guidelines for configuring Eclipse
IDE for U-Boot development. For more information, See
Section Appendix A, “ Configuring Eclipse IDE for U-Boot
Development.”
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Requirements

1

Requirements

The requirements for the U-Boot project are as follows:

2

Host computer with a Linux operating system
Basic knowledge of Linux

U-Boot source codefor thei.M X platforms. See Section 3, “ Getting the U-Boot Source Code,” for
information about the U-Boot source code

I.MX25 Multimedia Applications Processor Reference Manual (IMX25RM)
I.MX25 PDK 1.6 Linux User’s Guide

I.MX25 PDK Hardware User’s Guide (924-76349)

Basic knowledge of C language and ARM assembly language

Eclipse IDE with C/C++ development plug-in (required if the reader wants to follow the
instructions in the Section Appendix A, “Configuring Eclipse IDE for U-Boot Development.”)

U-Boot Overview

The U-Boot project is acombination of two small bootloaders—PPCboot and ARM boot—these
bootloaders are merged to create a U-Boot that provides support for expanded number of processors and
boards. The home page of this project is available at http://www.denx.de/wiki/U-Boot/WebHome. The
source code and documentation are distributed under the GPL license and is available free of cost.

The U-Boot project uses some portions of the Linux kernel code and maintains asimilar source code
structure and configuration scheme. This fact along with its set of features, stability, support for many
processors and boards, easiness of porting, and active community of developers enhancing and supporting
the project have contributed to make U-Boot, the most used bootloaders. The U-Boot iswidely used in the
embedded space where low-cost and reliability are critical.

The features of the U-Boot firmware are as follows:

Bootstrap the hardware platform

Load an OS image and transfer control to execute the OS

Network download—TFTP, BOOTP, DHCP, and NFS

Serial download—s-record and binary through Kermit

Flash management—copy, erase, protect, cramfs, and jffs2

Support for Flash types—CFI NOR Flash, NAND Fash, and MMC/SD cards
Memory utilities—copy, dump, crc, check, and mtest

IDE, SATA, boot from disk—raw block, ext2, fat, and reiserfs

Interactive shell—choice of simple or busybox shell with many scripting features

For further information about the U-Boot project and FAQ, visit the U-Boot home page available at
http://www.denx.de/wiki/U-Boot/WebHome.
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Getting the U-Boot Source Code

3 Getting the U-Boot Source Code

The U-Boot source code is shipped along with the Linux Board Support Package (BSP) for the i.MX25
Patform Development Kit (PDK). ThisBSPisembedded in the Linux Software Development Kit (SDK).
The Linux SDK for the i.MX25 processor and documentation is available at

http://www.freescal e.com/imx25pdk

At the time of creating this application note, the latest available version of Linux SDK was
IMX25 SDK16 LINUX_BSP, and it contained the BSP based on the Linux kernel version 2.6.28. To
install Linux BSP in the host computer, refer to the relevant documents.

After successful installation of the Linux BSP, the Linux Target Image Builder (LTIB) and GNU tool chain
(for ARM) areready for use. In this application note, the LTIB installation path is referenced as
<LTI B_DI R>.

To obtain the U-Boot source code for thei.MX platforms, use the following command:

cd <LTIB_ DI R>
./1tib -mprep -p u-boot

From this set of commands, the U-Boot source code packageis extracted and thei.MX patchesare applied.
The patched source code islocated at:

<LTI B_DI R>/ r pmi BUI LDY u- boot - 2009. 01
To rebuild the source code using LTIB, use the following command:
/1tib -mscbuild -p u-boot

Executing this command configures the U-Boot for the i.MX25 3-stack platform and the following
binaries are generated:
* u-boot—filein Executable and Linkable Format (ELF) with symbols and debugging information.
» u-boot.bin—plain binary file. Thisfile is programmed to a boot media (NAND, NOR, SD, and so
on) to bootstrap the i.MX25 3-stack board.
NOTE
The term 3-stack board is used to describe thei.MX development platform,
consisting of three boards—CPU, debug, and personality.

It isrecommended to verify with the Freescal erepresentativeif new U-Boot
patches or code is available for the i.MX platforms, prior to starting a code
customization.
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Source Code Tree Overview

4 Source Code Tree Overview

The U-Boot source code structure is similar to the one used by the Linux Kernel. This section gives an
overview of the source code tree. To list the directory tree, use the following command:

cd <LTIB_DI R>/r pm BU LD/ u- boot - 2009. 01

I's

Table 1 outlines the top-level directories in the source code tree and their description.

Table 1. U-Boot Source Code Top-Level Directories

Directory

Description

api

U-Boot machine/arch independent API for external applications

api_examples

Example applications using the API

board Board dependent files/directories
common Misc architecture independent functions
cpu CPU specific files

Disk Code for disk drive partition handling
Doc Basic documentation files

drivers Device drivers for common peripherals
examples Example code for standalone applications
Fs Common file systems support

include Header files (.h)

lib_arm Files generic to the ARM architecture
lib_avr32 Files generic to the AVR32 architecture
lib_blackfin Files generic to the blackfin architecture
libfdt Flat tree manipulation library
lib_generic Files generic to all architectures
lib_i386 Files generic to the i386 architecture
lib_m68k Files generic to the m68k architecture

lib_microblaze

Files generic to the microblaze architecture

lib_mips Files generic to the MIPS architecture

lib_nios Files generic to the Altera NIOS architecture

lib_ppc Files generic to the PowerPC architecture

lib_sh Files generic to the SH architecture

lib_sparc Files generic to the SPARC architecture

nand_spl Support for NAND Flash boot with stage 0 boot loader

net Networking support (bootp,tftp, rarp, nfs, and so on)

onenand_ipl One NAND initial program loader
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Table 1. U-Boot Source Code Top-Level Directories (continued)

Directory Description
patches Patches for the i.MX platforms (applied during the command ./Itib -m prep -p u-boot)
post Power on self test
tools Tools for building S-Record files, U-Boot images, and so on

Table 2 outlines thellist of filesin the top-level directory and their description.

Table 2. U-Boot Source Code Top-Level Files

File Description

README This file gives information about the U-Boot project. Several sections of this application note are based
on the information from this file.

Makefile The top-level Makef i | e. This file is used when executing the board configuration and the build
processes. The new board configurations are to be added to this file.

MAKEALL This script is used to configure and build all the supported boards in one step. The list of boards in this
file must be updated manually when a new board is added.

CREDITS The author and main contributors of the U-Boot project are listed in this file (includes their email).

COPYING This file contains the license of the U-Boot source code.

4.1 i.MX25 Related Source Files
The i.MX25 application processors (based on ARM926EJ-S) and its development platform (3-stack

board) are added to the U-Boot project.

Table 3 outlines the 3-stack related source files in the source code tree and their description.
Table 3. i.MX25 3-Stack Related Source Files

Directory/File

Description

board/freescale/mx25_3stack/dcdheader.S

Image header that is appended to the u-boot.bin file; includes Device
Configuration Data (DCD)

board/freescale/mx25_3stack/lowlevel_init.S

Board low-level initialization routines in the assembly language

board/freescale/mx25_3stack/mx25_3stack.c

Board initialization routines in the C language

board/freescale/mx25_3stack/u-boot.lds

Linker script

board/freescale/mx25_3stack/config.mk

Defines the base address for binary (TEXT_BASE)

cpu/arm926ejs/cpu.c

CPU specific code in the C language: interrupts, stack, mmu, and cache setup
routines

cpu/arm926ejs/interrupts.c

Nothing really useful here

cpu/arm926ejs/start.S

CPU low-level initialization code, the first function executed when U-Boot starts
is defined here

cpu/arm926ejs/mx25/generic.c

Routines for calculating CPU and peripheral clocks and a function to call the
on-chip Ethernet initialization routine
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Table 3. i.MX25 3-Stack Related Source Files (continued)

Directory/File

Description

cpu/arm926ejs/mx25/gpio.c

Routines for setting up the General Purpose Input/Output (GPIO) pins

cpu/arm926ejs/mx25/interrupts.c

Starts a timer and provides functions around the timer count. Also, implements
the r eset _cpu function

cpu/arm926ejs/mx25/iomux.c

IOMUX setup routines

cpu/arm926ejs/mx25/serial.c

On-chip Universal Asynchronous Receiver/Transmitter (UART) driver and serial
I/O functions

include/asm-arm/arch-mx25/gpio.h

GPIO function definitions

include/asm-arm/arch-mx25/iomux.h

IOMUX control definitions and functions

include/asm-arm/arch-mx25/mmc.h

Nothing is defined here

include/asm-arm/arch-mx25/mx25-regs.h

On-chip modules base addresses and registers definitions

include/asm-arm/arch-mx25/mx25.h

Definitions of functions to get clocks

include/asm-arm/arch-mx25/mx25_pins.h

i.MX25 I/O pin list

include/asm-arm/arch-mx25/mxc_nand.h

NAND Flash Controller (NFC) registers definitions and macros

include/asm-arm/arch-mx25/sdhc.h

Secure Digital Host Controller register definitions and functions

include/configs/mx25_3stack.h

i.MX25 3-stack board high-level configuration

lib_arm/board.c

This file implements high-level board initialization functions and allows the user
to configure the initialization sequence

drivers/mtd/nand/mxc_nand.c

NFC low-level driver

drivers/mtd/nand/nand.c

NAND Flash definitions and initialization function

drivers/mtd/nand/nand_base.c

NAND Flash generic to the Memory Technology Device (MTD) driver

drivers/mtd/nand/nand_bbt.c

Bad block table support for the NAND Flash driver

drivers/mtd/nand/nand_ecc.c

Error correction code support for NAND Flash

drivers/mtd/nand/nand_ids.c

NAND Flash chips ID list

drivers/mtd/nand/nand_util.c

Utilities to work with NAND Flash, write and read skipping bad blocks, lock the
NAND Flash during accesses, and so on

drivers/mmc/fsl_esdhc.c

Functions to use the MMC/SD card

drivers/mmc/fsl_mmc.c

1/O control access for the MMC/SD cards

common/env_mmc.c

Functions to store and retrieve the environment variables from the MMC/SD
card

drivers/i2c/mxc_i2c.c

I2C driver for the i.MX architecture

drivers/net/smc911x.c

SMSC911x Ethernet device driver (used for SMSC LAN9217)

drivers/net/mxc_fec.c

On-chip Fast Ethernet Controller (FEC) device driver
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Create a New Board Based on i.MX25 3-Stack

In the process of adapting U-Boot to a custom design, it is recommended to create a new board directory
within the code tree where all the files and new configurations can be stored. Thisway, the original files
that are used as base (in this case, the i.MX25 3-stack board) remains unchanged and available for
comparison. If the device drivers or any other non-board specific code is adapted, it is agood practice to
take abackup copy of the original code and make it availablein the source tree for comparison. If required,
see Section Appendix A, “Configuring Eclipse IDE for U-Boot Development,” for information about
Eclipse IDE configuration before proceeding with the following sections.

To create a new board based on the i.MX25 3-stack, perform the following steps:

1.

Clean the source code tree (all the output files of previous build are deleted):

meke di stcl ean
Copy the contents of the current m«25_3st ack board directory to a new directory and provide a
meaningful name to identify the design. This application note uses mx25_cust om as a new
directory name.

cp -r board/freescal e/ mk25_3stack/ board/freescal e/ nx25_custom
Rename the mx25_3st ack. ¢ file accordingly:

mv boar d/ freescal e/ mx25_cust om mx25_3st ack. ¢
board/ freescal e/ mx25_cust omf mx25_custom ¢

Adjust the boar d/ fr eescal e/ mx25_cust oml Makef i | e fileto fit the new file name:

Changetheline, coBis  : = mx25_3stack.o,t0COBIS := mx25_custom o
Copy the contents of the current mx25_3st ack board configuration file to a new file and provide a
meaningful name. This application note uses mx25_custom h as anew file name.

cp include/configs/m25_3stack. h include/ configs/m25_custom h
Create an entry in the top-level directory, vakefi | e, for the new custom board configuration. This
fileis sorted in the alphabetical order:

mx25_custom config : unconfig
@(MKCONFI G $(@ _config=) arm arm26ej s nmx25_custom freescal e nx25

NOTE

The U-Boot project developers recommend to add any new board to the
MAKEAL L Script too and run the script to verify if the new code has not broken
any other platform builds. Thisis necessary if a patch is submitted back to
the U-Boot community. For further information, consult the U-Boot READVE
file.

Adapt to any fixed paths. In this case, the linker script, mx25_cust om u-boot . I ds has one path.
Replace mx25_3st ack With m25_cust omusing the following command:

board/ freescal e/ nx25_cust onf dcdheader . o
Set the cross_cowpi LE and PATH environment variables in the console as the build processis
executed manually (without LTIB):

export CROSS_COWPI LE=ar m none- | i nux-gnueabi -
export

U-Boot for i.MX25 Based Designs, Rev. 0
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PATH=/ opt/ freescal e/ usr/l ocal /gcc-4.1.2-glibc-2.5-nptl-3/arm none-1|inux-gnueabi/bin
/ : $PATH

9. Configure the system for the new board:

make nx25_custom config
10. Build the new board. Verify that no errors are found and the U-Boot binaries are created:

make

The new board isareplicaof thei.MX25 3-stack board. The next step isto adapt some portions of the code
to make it suitable for the new hardware design.

The following sections provide guidelines to proceed further with the code customization process.

6 Customize the Code

This section describes the key areas within the source code where customizing is required. Also, note that
depending on the design and requirements, the code is modified either more or less than what is explained
in this application note.

6.1 Internal Boot versus External Boot

The i.MX25 applications processor provides different boot modes and these are described in detail in the
i.MX25 Multimedia Applications Processor Reference Manual (IMX25RM).

The boot modes of the i.MX25 processor are as follows:

» Internal boot mode—allows selection of all boot sources such as NOR, NAND, MMC/SD,
OneNAND, Parallel Advanced Technology Attachment (P-ATA), Serial ROM/Flash, and so on.
After Power On Reset (POR) or reset, the processor’'s ROM code samples the boot pins or eFuses
and loadsthefirst set of code from the selected boot media. This code must have a Flash header at
aparticular offset and it varies depending on the boot source. The Flash header stores information
about the application in a specific structure. It can also store DCD, which is ablock of data
processed by the i.M X 25 to configure the hardware at boot time. This enables the configuration of
some on-chip modules and external peripherals before moving to the entry point of the application.

» External boot mode—allowsselection of only the NOR and NAND Flash asthe boot sources. After
POR or reset, thei.MX25 processor samplesthe boot pins or eFuses, and jumps directly to the base
address of the selected boot source (base of NFC buffer in the case of NAND Flash). No Flash
header is required to identify the application and the hardware configuration is carried out by the
loaded application.

6.2 Flash Header

The Flash header boar d/ mx25_cust om dcdheader . S iS appended to the top of the u- boot . bi n file as
indicated by the linker script. One of the elements of the Flash header isthe DCD, which isablock of data
processed by thei.MX25 ROM code to configure some on-chip modules and external peripherals at boot
up. For more information, refer to the System Boot chapter of the i.MX25 Multimedia Applications
Processor Reference Manual (IMX25RM).

U-Boot for i.MX25 Based Designs, Rev. 0
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The Flash header is appended to the image when the following configurations are set:

#defi ne CONFI G_FLASH HEADER 1

#define CONFI G FLASH HEADER OFFSET 0x400

#def i ne CONFI G_FLASH HEADER BARKER 0xB1

In addition, if DCD isused and the SDRAM initiaization is performed by the DCD data, the user can set
the following configuration to disable the U-Boot relocation to RAM, because it is already performed by
thei.MX ROM code:

#def i ne CONFI G_SKI P_RELOCATE_UBCOT

6.3 Customize SDRAM Initialization

If the SDRAM deviceis modified in the custom platform, the i.MX25 Enhanced SDRAM Controller and
initialization sequence code require adaptation to operate with the new device.

In this case, modify the Flash header (DCD data)—open the dcdheader . s file and modify the values of the
DCDGEN macros (add/remove values) in accordance with the specification sheet of SDRAM devicesand
the i.MX25 Multimedia Applications Processor Reference Manual (IMX25RM).

The DCDGEN macro transforms an identifier number, address of aregister, avaluetowritetothisregister,
and length of the access into the corresponding data, which isto be appended to the U-Boot binary.

NOTE
Ensure to adjust the length of the DCD structureif datais added or removed
fromit.
If the SDRAM base or the szeischanged, the following valuesin the custom board configuration file need
to be modified:

#define PHYS_ SDRAM 1 CSDO_BASE

/* 1 MX25 V-1.0 has 128MB but V-1.1 has only 64MB */
#i f def CONFI G_MX25_3DS V10

#def i ne PHYS_SDRAM 1_SI ZE (128 * 1024 * 1024)
#el se
#def i ne PHYS_SDRAM 1_SI ZE (64 * 1024 * 1024)
#endi f

6.4 Check if the CPLD Code is Required

Thei.MX PDKs (3-stack) contain a debug board in which glue logic isimplemented in a Complex
Programmable L ogic Device (CPLD). Thisdeviceis memory mapped to the on-chip WEIM at Chip Select
5(CS5).
The CPLD supports the following features:

* A 16-bit slaveinterface to the CPU data bus

* Address decode and control for the external Ethernet controller

» Address decode and control for the external UART controller

* Level shift for Ethernet signals and UART signals

U-Boot for i.MX25 Based Designs, Rev. 0
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» Control and status registers for various board functions

When the new board does not have the CPLD or the memory range of CS5 (0xB600_0000 -
OxB7FF_FFFF) isused for adifferent purpose, it is necessary to remove the code targeting the CPLD to
avoid possible errors.

To clarify further on this point, imagine that the new board has an external Ethernet controller that is
attached directly to thei.MX processor at CS5. If CPLD initialization code is executed, it can corrupt the
externa Ethernet chip initialization and prevent the device driver of this peripheral from operating
correctly.

One such caseiswhen the new board requires CS5 for adifferent purpose, it is advisable to have only the
CS5initialization and remove the CPLD (aias debug board or peripheral bus controller) initialization.

Another caseiswhen CS5 is not used in the new board, there is no need to execute the unused code. In
such case, remove both the CS5 initialization and the CPLD initidization.

To remove/comment the CS5 and/or CPLD code in U-Boot source files, look for references to the
following keywords—CS5, DBG, and PBC. Also, look for other references to the CS5 address space.

For example, in the i.MX25 custom board, if no CS5 is required, comment out the following code:

In the dcdheader . s file, remove the CS5 configuration data from the DCD:

/* WEIMconfig-CS5 init -- CPLD */

DCDCGEN( 1, 4, 0xB8002050, 0x0000D843) /* CS5_CSCRU */
DCDCGEN( 2, 4, 0xB8002054, 0x22252521) /* CS5_CSCRL */
DCDCGEN( 3, 4, 0xB8002058, 0x22220A00) /* CS5_CSCRA */

NOTE
Ensureto adjust the length of the DCD structure when dataisremoved from
it.
Inthe ow evel _init. s file, remove the following code:

/* Init Debug Board CS5 */
REG 0xB8002050, 0x0000D843
REG 0xB8002054, 0x22252521
REG 0xB8002058, 0x22220A00

If CS5 needsto beinitialized without wanting the code to interact with the CPLD logic, look for accesses
made to the CS5 address space. For example, refer to the following constants (these are not found in the
current U-Boot code of i.MX25 3-stack but can be found in the future U-Boot code):

#define PBC_LED CTRL (0x20000)
#define PBC_SB_STAT (0x20008)
#define PBC_| D_AAAA (0x20040)
#define PBC_| D 5555 (0x20048)
#def i ne PBC_VERSI ON (0x20050)
#define PBC_| D_CAFE (0x20058)
#defi ne PBC_| NT_STAT (0x20010)
#def i ne PBC_| NT_MASK (0x20038)
#def i ne PBC_I NT_REST (0x20020)
#def i ne PBC_SW RESET (0x20060)

U-Boot for i.MX25 Based Designs, Rev. 0
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6.5 Board Initialization Sequence

As part of the U-Boot boot up process, the st art _ar mboot function executes the initialization sequence of
aboard. This sequence definesthe order in which other routinesare called and it is customized by the user.
To adapt it, modify thei ni t _sequence[] array definedinthelib_arn board. ¢ file:

init_fnc_t *init_sequence[] = {

cpu_init, /* basic cpu dependent setup */
board_init, /* basic board dependent setup */
interrupt_init, /* set up exceptions */
env_init, /* initialize environnment */
i ni t_baudrate, /* initialze baudrate settings */
serial _init, /* serial communications setup */
console_init_f, /* stage 1 init of console */
di spl ay_banner, /* say that we are here */
#i f defi ned( CONFI G_DI SPLAY_CPUI NFO)
print_cpuinfo, /* display cpu info (and speed) */
#endi f
#i f defi ned( CONFI G_DI SPLAY_BOARDI NFO)
checkboard, /* display board info */
#endi f

#if defined(CONFI G HARD | %C) || defined(CONFI G_SOFT_I ’C)
init_func_iZc,

#endi f
dram.init, /* configure avail abl e RAM banks */
di spl ay_dram confi g,
NULL,

b

6.6 Include, Exclude, or Remap Device Drivers

After the build, the U-Boot binary should only include the code to be used at the target board. Thei.MX25
3-stack board configuration file includes device drivers such as I°C, UART, FEC, NAND, and so on for
both the on-chip and off-chip peripherals.

In the process of customizing U-Boot, the driversincluded in the custom board configuration file must be
reviewed to verify if al of these driversare needed for the design. Depending on the requirements, include
or exclude the device drivers, or remap them in case the base address has changed in the design. Some
examples are described in the following sections.

6.6.1 UART Driver

The current configuration includes the UART driver using the conFi G_mx25_UaART constant and selects the
UART 1 driver using the conFl G mx25_uarT1 constant. To remap the UART driver, refer to themx2s-regs. h
file and identify the base address of the UART driver which isto be used and perform the following steps.

1. Changethe‘l usedinthe#define ConFl G Mx25_uaRT1 file with the UART number which is used.

2. Changethe*l usedintheifdef CONFI G MX25_UART1 iN cpu/ armp26ej s/ mx25/ seri al . ¢ file with
the UART number which is used.

3. Change the physical base addressin the #defi ne UART_PHYS 0x43f 90000 in
cpu/ ar m26ej s/ nk25/ seri al . ¢ file with the base address of the UARTX which is used.

U-Boot for i.MX25 Based Designs, Rev. 0
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4. Change the [OMUX and pad configuration for the UARTX in
boar d/ fr eescal e/ mk25_3st ack/ mk25_3st ack. ¢ With the new UART number.

/* setup pins for UART1 */

/* UART 1 | OMJUX Configs */

mxc_request _i onux(MX25_PI N_UART1_RXD, MJX_CONFI G_FUNC) ;

mxc_request _i onux(MX25_PI N_UART1_TXD, MJX_CONFI G_FUNC) ;

mxc_request _i omux(MX25_PI N_UART1_RTS, MJX_CONFI G_FUNC);

mxc_request _i omux(MX25_PI N_UART1_CTS, MJX_CONFI G_FUNC);

mxc_i onux_set _pad(MX25_PI N_UART1_RXD, PAD_CTL_HYS_SCHM TZ | PAD_CTL_PKE_ ENABLE|
PAD CTL_PUE _PUD | PAD CTL_100K_PU);

mxc_i onux_set _pad(MX25_PI N_UART1_TXD, PAD CTL_PUE_PUD | PAD CTL_100K_PD);

mxc_i onux_set _pad(MX25_PI N_UART1_RTS, PAD_CTL_HYS_SCHM TZ | PAD_CTL_PKE_ ENABLE|
PAD _CTL_PUE _PUD | PAD CTL_100K_PU);

mxc_i onux_set _pad(MX25_PI N_UART1_CTS, PAD CTL_PUE_PUD | PAD CTL_100K_PD);

6.6.2 SMSC Ethernet Driver

Asmentioned in Section 6.4, “ Check if the CPLD CodeisRequired.” the SMSC LAN9217 device located
in the debug card is interfaced through the CPLD logic and therefore mapped out at an offset within CS5
(check CPLD memory map). In the case of SMSC device, this offset is 0 and therefore the CS5 base
address is same as the SMSC driver.

If the SMSC LAN9217 or a compatible deviceis present in the new board, the driver code must be
included to the U-Boot build. To do so, add the following definitions in the custom board configuration
file:

/ *Support LAN9217*/

#define CONFI G_SM911X 1

#def i ne CONFI G SMC911X_16 BIT 1
#def i ne CONFI G_SMC911X_BASE CS5_BASE_ADDR

While including or excluding the Ethernet device drivers, assign a suitable value to the multiple Ethernet
interface definitions. The U-Boot build uses the following configurations to know how many Ethernet
devices are present in the system.

#def i ne CONFI G_HAS ETHI1
#define CONFI G NET_MULTI 1

6.6.3 MMC Driver and Commands

Depending on the need, the MM C device driver isincluded or excluded from the U-Boot build. To do so,
add or remove the following definitions from the board configuration file:

#define CONFI G FSL_MMC / /1 ncludes the MMC dri ver

#def i ne CONFI G_MVC 1 //Required for other definitions inside the MMC driver
#define CONFI G CMD_MVC // Enabl es the MMC U Boot conmands

#def i ne CONFI G_DOS_PARTI Tl ON 1 //Enables DCS partition read/wite

#define CONFI G_CMD_FAT 1 //Enabl es the U-Boot FAT commands

#def i ne CONFI G_MMC_BASE 0x0 //Defines the base of MMC card

#define CONFI G ENV_IS | N.MVC 1 //Environment variables will be stored in MMC card
#def i ne CONFI G_ENV_OFFSET (768 * 1024) // O fset within the MMC card where the
environnent variables will be stored at

U-Boot for i.MX25 Based Designs, Rev. 0
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6.6.4 NOR Flash Driver and Commands

The NOR Flash driver (Common Flash Interface) and the Flash commands are included only when the
following definitions are used. In this case, CS0 is the base for the NOR Flash. Modify the values
according to the new board configuration:

#def i ne CONFI G_SYS_FLASH BASE CS0_BASE_ADDR

#def i ne CONFI G_SYS_MAX_FLASH BANKS 1 /* max nunber of nenory banks */
#define CONFI G_SYS_MAX_FLASH SECT 512 /* max nunber of sectors on one chip */
/* Monitor at beginning of flash */

#def i ne CONFI G_SYS_MONI TOR_BASE CONFI G_SYS_FLASH BASE

#define CONFI G_SYS_MONI TOR_LEN (512 * 1024)

% e e e e e e e emeeeea-

* CFl FLASH driver setup

*/

#def i ne CONFI G_SYS_FLASH_CFI 1/* Flash nenmory is CFl conpliant */
#define CONFI G_FLASH CFI _DRI VER 1/* Use drivers/cfi_flash.c */

/* A non-standard buffered wite algorithm?*/

#define CONFI G FLASH SPANSI ON_S29Ws N 1

#define CONFI G_SYS_FLASH USE_BUFFER WRI TE 1/* Use buffered writes (~10x faster) */
#define CONFI G_SYS_FLASH_PROTECTI ON 1/* Use hardware sector protection */

6.6.5 NAND Flash Driver and Commands

When the conFl G Mx25 and conFl G ovb_ NAND macros are defined, the NAND Flash driver and the
commands are included to the U-Boot build. Since disabling the conFi G_mx2s macro impacts other
functionalities, it is recommended to create a specific #def i ne macro for the NAND low-level driver
(mxc_nand. c¢), so that the NAND Flash Driver can be enabled or disabled like the other drivers.

For the NAND driver and MTD subsystem, it isimportant to highlight the place where the NAND chip
IDs are defined. Thisis because sometimesit is necessary to add anew NAND manufacturer or Device
ID to the list of supported NANDs. To do so, check the following structures in the

drivers/ ntd/ nand/ nand_i ds. c file:

struct nand_flash_dev nand_flash_ids[] = {

{"NAND 128M B 1,8V 16-bit", 0x49, 512, 128, 0x4000, NAND BUSW DTH 16},
{"NAND 128M B 3,3V 16-bit", 0x74, 512, 128, 0x4000, NAND BUSW DTH 16},
{"NAND 128M B 3,3V 16-bit", 0x59, 512, 128, 0x4000, NAND BUSW DTH 16},
{"NAND 256M B 3,3V 8-bit", 0x71, 512, 256, 0x4000, O},

{NULL, }

struct nand_manuf acturers nand_manuf _i ds[] = {
{NAND_MFR_TOSHI BA, "Toshi ba"},
{NAND_MFR_SAMSUNG, "Sansung"},
{NAND_MFR_FUJI TSU, "Fujitsu"},

{0x0, "Unknown"}

U-Boot for i.MX25 Based Designs, Rev. 0
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6.6.6 I2C Driver

The 12C communications channel is used to interface with the Power Management IC (PMIC) in the

i.MX 25 3-stack board. In this board, the 1°C port 1 isused with the base address 0x43F80000. If PMIC is

relocated to another 12C port or if it is changed, make sure to modify the code at the following locations:
® include/configs/m25_custom h:

#defi ne CONFI G CMD | 2C

#defi ne CONFI G_HARD |2C 1
#defi ne CONFI G | 2C_MXC 1

#defi ne CONFI G_SYS | °C_PORT |2C1_BASE_ADDR

#defi ne CONFI G_SYS_| °C_SPEED 40000

#defi ne CONFI G _SYS | °C_SLAVE oxfe

* board/ freescal e/ m25_cust oml mx25_cust om ¢ (inside the board_i ni t function):

nmxc_request _i onux(MX25_PI N | 2C1_CLK, MUX_CONFI G SI ON) ;

mxc_request _i omux( MX25_PI N_I 201_DAT, MUX_CONFI G_SI ON) ;

nxc_i omux_set _pad(MX25_PI N_| 2C1_CLK, Ox1ES8);

nxc_i omux_set _pad( MX25_PI N_| 2C1_DAT, Ox1ES8);
Also, if BoARD_LATE_I NN T macro is defined in the board configuration file, the function board_I at e_i ni t
intheboard/ f reescal e/ mx25_cust om mx25_cust om ¢ fileisincluded and executed. Thisfunction performs
awrite operation to a PMIC register and it works if the PMIC I%C port isremapped. However, if PMIC is
modified, the function does not work. Therefore, adapt or exclude this code from the U-Boot build.

6.7 Miscellaneous Customizations

This section describes the various types of customizations with the help of code.

6.7.1 Environment Variables and Auto Boot Command

The U-Boot shell allows the user to set environment variables similar to the Linux shell. These variables
can be defined at the U-Boot prompt using the set env command or can be hardcoded in the source code.
One of these variables, boot cnd is executed automatically when the auto boot feature is enabled. To
configure these elements, refer to the custom board configuration file and modify the following code:

#def i ne CONFI G_BOOTDELAY 3
#def i ne CONFI G_LOADADDR 0x80800000 /* | oadaddr env var */
#def i ne CONFI G_EXTRA_ENV_SETTI NGS \

"net dev=et hO\ 0"

"et hpri me=f ec\ 0"

"boot ar gs_base=set env boot args consol e=ttynmxc0, 115200\ 0"

"boot ar gs_nfs=set env bootargs $(bootargs) root=/dev/nfs "
"i p=dhcp nfsroot=$(serverip):$(nfsrootfs),v3, tcp\0" \

"boot crd=run boot cnd_net\ 0"

"boot cd_net =run boot args_base bootargs_ntd bootargs_nfs; "
"tftpboot 0x81000000 ul mage; boot m 0"

— e o —

—

6.7.2 Change | and U-Boot Prompt

When the U-Boot boots up and before it reaches the prompt, there are some debug messages displayed in
the console and one of these messages is the name of the board. Thisis printed when executing the

U-Boot for i.MX25 Based Designs, Rev. 0
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checkboard function in the boar d/ fr eescal e/ mx25_cust onf mx25_cust om c file. If required, replace the
name of the board with a suitable string.

int checkboard(void)

{
printf("Board: i.MX25 MAX PDK (3DS)\n");

return O;

}

The U-Boot prompt is displayed after all the setup functions are executed. The string that is displayed at
the prompt can be changed inthei ncl ude/ confi gs/ mx25_custom h file with the following definition.

#def i ne CONFI G_SYS_PROVPT "MX25 U Boot > "

6.7.3 Change the Linux Machine Type and Address of ATAGs

When the U-Boot is used to boot a Linux Operating System (OS), the kernel parameters are placedina
special areain memory in the form of ATAGs (if this feature isenabled in the board configuration file).
The address of thislocation in memory is user configurable. In addition, one of these parameters passed
to the kernel isthe machine type, which isanumber used to identify the board and it must match between
Linux and U-Boot. If the machine type does not match, the Linux kernel does not boot up. To change these
parameters, refer to the boar d/ f reescal e/ m25_cust om mk25_cust om ¢ file and modify the following lines
of code:

gd- >bd- >bi _ar ch_nunber
gd- >bd- >bi _boot _par ans

MACH_TYPE_MX25_3DS; /* board id for linux */
0x80000100; /* address of boot paraneters */

The ATAGs are enabled with the following definitions in the board configuration file:

#define CONFI G_CMDLI NE_TAG 1 /* enabl e passing of ATAGs */
#def i ne CONFI G_SETUP_MEMORY_TAGS 1
#define CONFI G_I Nl TRD_TAG 1

7 Enable Debugging Information

While customizing U-Boot, debugging is the most time consuming activity. During this phase, it is useful
to have as much information as possible to detect the root cause for errors. For this purpose, the U-Boot
source code contains several functions or macrosthat, when enabled, print extrainformation in the console
at runtime. Some examples are as follows:

In thei ncl ude/ common. h file, two debug macros are defined. When the #defi ne DEBUGMacrois setin this
file, all thefilesthat includecomon. h and usethedebug(fnt, args..) Of debugX(!evel, fnt, args.) Macro
printsthe additional information. If too much information is printed, enable the #def i ne DEBUG Macro only
in aparticular file(s) before including common. h. In both cases, the source code needs to be recompiled.

In addition, there are other files that have their own debug macros or functions. In MTD subsystem and
NAND driver, the #defi ne conFl G MrD_DEBUG file and a debug level are used to print the additional
information. Other examples are #def i ne DEBUG SPI in the SPI subsystem, #defi ne DEBUG | 2Cinthe 12C
subsystem, and #def i ne DEBUG JFFS2.

U-Boot for i.MX25 Based Designs, Rev. 0
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8 Revision History
Table 4 provides the revision history for this application note.

Table 4. Document Revision History

Rev.
Number

Date

Substantive Change(s)

0

07/2010

Initial release
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Appendix A Configuring Eclipse IDE for U-Boot
Development

To assist during the source code customization process, it is recommended to set up an Integrated

Development Environment (IDE) in the host computer. This section provides the instructionsto set-up the
Eclipse IDE (for C/C++ developers).

Eclipseinstallation is beyond the scope of this application note. For information about installing Eclipse
in the host computer, refer to the following link—http://www.eclipse.org/cdt/

After ingtalling the Eclipse IDE in the Linux host, perform the following steps to configure the Eclipse
IDE for the U-Boot development:

1. Open Eclipse.
2. Click on File> New > Project.
3. Inthe New Project wizard, select C > Standard Make C Project. (See Figure 1)

Figure 1 shows the new project wizard of the Eclipse IDE.

= New Project

x]
Select a wizard —
Create a new C Project which uses a simple makefile.
Wizards:
pe filter text
%% Java Project
s Java Project from Existing Ant Buildfile
 Plug-in Project
b (= General
v=C
£ Managed Make C Project
]
e e B
@ < Back | Next > | Finish Cancel

Figure 1. Eclipse IDE New Project Wizard
4. Click Next.

5. The C/Make Project window appears. Type a project name in the Project name field and deselect
the Use default location check box.

6. Click onthe Browse button to search for the path where the U-Boot source code is located. (See
Figure 2)
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Figure 2 shows the name and location of the project.

= New Project

|T|
C/Make Project .
Create a New C Project using 'make’ to build it @

Project name: ILI-Et}ot_Customized|

[ Use default location
Location: | /homejuserltib/pm/BUILD/u-boot-2009.01 Browse... |

@ < Back Next > | Einish I Cancel |

Figure 2. Project Name and Location

7. Click on the Finish button to close the wizard.
8. In the Eclipse main window, deselect the Project > Build automatically option.
9. Configure the project properties. Click on Project > Properties to open the properties window.

10. Select the C/C++ Include Paths and Symbols option and perform the following stepsin this
window:
— Disableall theautomatically discovered paths and symbols (multiple selection isallowed to
disable all of them at once).
— Add the include path from workspace. For example—U-Boot_Customized/include. (See
Figure 3)
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Figure 3 shows the paths to be included from the workspace.
C/C++ Include Paths and Symbols Gav e

Include Paths and Preprocessor Symbols:

< 2= U-Boot_Customized Add Folder/File...

=i Discovered Paths

- & U-Boot_Customizedjinclude Add Preprocessor Symboal...

*» Exclusion filter: (None)

Add Extemnal Include Path...

Add Include Path from Workspace...

Add Contributed...

Edit

Remove

Export

Down

Show Inherited Paths

Figure 3. Include Path from Workspace

11. Select the C/C++ Indexer and perform the below steps:
— Itisrecommended to enablethefast C/C++ Indexer to have assi sted source code navigation.
Optionally, the full indexer can be selected, but this takes more time to complete.

12. Select the C/C++ Make Project and perform the below steps:
— Make Builder tab:
Deselect the Build on resource save (Auto Build) option.
Select Stop on first build error option.

— Environment tab:
Select the Replace native environment with specified environment radio button.

Add the environment variableslisted in Table 5. (See Figure 4)
Table 5 shows the environment variables that are to be set.

Table 5. Environment Variables to Set

Variable Value

CROSS_COMPILE arm-none-linux-gnueabi

PATH /opt/freescale/usr/local/gcc-4.1.2-glibc-2.5-nptl-3/arm-none-linux-gnueabi/bin/:/usr/local/sbin:/usr/lo
cal/bin:/usr/sbin:/usr/bin:/sbin:/bin
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Figure 4 shows the environment variables in the Eclipse make builder.

Make Builder Envimnmentl Error Parsersl Binary Parserl Discovery Dpticnsl

Environment variables to set

Variable | value
® CROSS COMPILE  arm-none-linux-gnueabi-
joptffreescalefusrflocal/gcc-4.1.2-glibc-2.5-nptl-3/arm-none-linux-gnueabi/bin:fopt/amr

- (= Edit Environment Variable =

Name: |PATH

Value: |foptffreescalefusrﬂocalfgcc-il.l. Variables... |
OK I Cancel |

(O Append environment to native environment
® Replace native environment with specified environment

Figure 4. Environment Variables in Eclipse Make Builder

— Binary Parser tab:
Deselect the Elf parser.
Select the GNU EIf Parser and configure the addr2line and c++filt commands as listed in
Table 6.
Table 6 showsthe GNU binary parser selection.
Table 6. GNU Binary Parser Selection

Binary Parser Options Value
addr2line /opt/freescale/usr/local/gcc-4.1.2-glibc-2.5-nptl-3/arm-none-linux-gnueabi/bin/arm-none-linux-gnu
eabi-addr2line
c++filt /opt/freescale/usr/local/gce-4.1.2-glibc-2.5-nptl-3/arm-none-linux-gnueabi/bin/arm-none-linux-gnu
eabi-c++filt
— Discovery Options tab:

Deselect the Automate discovery of paths and symbols option.
13. Click OK to save and close the properties window.
14. Go to Project > Create Make Target to open a new window. For the U-Boot project, create the
make targets listed in Table 7. (See Figure 5)
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Table 7 shows the target names and their descriptions.

Table 7. Make Targets to Create

Target Name Make Target Description

Dist Clean distclean Full clean up of the source tree

i.MX25 3-Stack mx25_3stack_config Configure the U-Boot source tree to be built for
an i.MX25 3-stack board.

i.MX25 Custom mx25_custom_config Configure the U-Boot source tree to be built for
a custom i.MX25 based design.

The make targets are used to configure the system for the target board before executing the build process.
If the system is not configured, an error is shown as below:

Make al |

Syst em not configured - see READVE
Make: *** [all] Error 1

Additionally, the Dist Clean target is used to perform afull clean up of the source tree (remove al the
resulting files of previous build).

Figure 5 shows the making of the targets in eclipse projects.

Make Targets
Modify a Make target

Make Targets for:
Target Target Name: |HIEeSEeIE Gy
(@ Dist Clean Make Target

@ i.MX25 3-Stach

Make Target: |mx25_custom_conﬁg
o

Build command
Use default

Build command: |make

Build Setting
Stop on first build error.
Run all project builders.

Figure 5. Make Targets in Eclipse Project

After successful configuration of the Eclipse IDE, follow the build steps below:
* Build the Dist Clean make target (optional).

» Configure the system using the desired make target (from the list above).
* Build the project.

After successful build, the output files are placed in the U-Boot source code path. (See Figure 6)
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Figure 6 shows the output of the build process at the console.

REN 2 Console x Pmperties|5eamh| & G|t B-3- © O
C-Build [U-Boot_Customized]
T L Lt~ bl L

drivers/gpio/libgpio.a drivers/hwmon/libhwmon.a drivers/i2c/1ibi2c.a drivers/input/libinput.a drivers/misc/libmisc.a
drivers/mmc/libmmc.a drivers/mtd/libmtd.a drivers/mtd/nand/libnand.a drivers/mtd/nand legacy/libnand legacy.a drivers/
|mtd/onenand/libonenand.a drivers/mtd/ubi/libubi.a drivers/mtd/spi/libspi flash.a drivers/net/libnet.a drivers/net/phy/
libphy.a drivers/net/sk981in/1ibsk981lin.a drivers/pci/libpci.a drivers/pcmcia/libpemcia.a drivers/spi/libspi.a drivers/
rtc/librtc.a drivers/serial/libserial.a drivers/usb/libusb.a drivers/video/libvideo.a common/Llibcommon.a libfdt/
libfdt.a api/libapi.a post/libpost.a board/freescale/mx25 3stack/libmx25 3stack.a --end-group -L /opt/freescale/usr/
local/gcc-4.1.2-glibc-2.5-nptl-3/arm-none-1linux-gnueabi/1lib/gcc/arm-none-1linux-gnueabi/4.1.2 -lgcc \

-Map u-boot.map -o u-boot
arm-none-linux-gnueabi-objcopy -0 srec u-boot u-boot.srec
arm-none-linux-gnueabi-objcopy --gap-fill=@xff -0 binary u-boot u-boot.bin| :J

Figure 6. Console Output of Building Process
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